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Introduction to the Software AG IDL Extractor for Natural

Scope

The Software AG IDL Extractor for Natural extracts a Software AG IDL definition from a Natural
source in a Natural project in Eclipse, or from an object within a Natural RPC environment.

In a user-driven process supported by an extractor wizard (see Using the Software AG IDL Ex-
tractor for Natural), the interface of a Natural subprogram (CALLNAT) is extracted, optionally
along with various features offered by the Design Interface for Natural Subprogram page modelled
to a client interface.

Wizard
Select Select :
Natural 1 > Natural 1 > Design Interfaces |~ >
Library Subprograms for Natural
Subprograms
T T T
Cliznt )
Interface a5 required
| . I' —
Natural ! v t?"' ‘ﬂ
Subprogram { M|
(CALLNAT) IDL -

The result of this process is an IDL file and, optionally, a related client-side server mapping file
(CVM) mapping the client interface to the Natural subprograms (CALLNATS):

= IDL File
The Software AG IDL (interface definition language) file contains the modelled interface of the
Natural server. In a follow-up step, the IDL file is the starting point for the RPC client-side
wrapping generation tools to generate client interface objects. See EntireX Wrappers.

* CVM File
A CVM file (client-side server mapping file) to complete the mapping is generated only if it is
required by the RPC server during runtime to call the Natural server. For information on when
a CVM file is required, see When is a CVM File Required?
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extract i
I g ‘
input
Natural > IDL Extractor
Server for Matural
as required "
| "'[ CVM W
Extractor Wizard

The extractor wizard guides you through the extraction process and supports the following tasks:

" Accessing Natural subprograms (CALLNATSs), sources or object files, either in the local file
system where the EntireX Workbench is running, or remotely from the host computer with the
RPC server extractor service.

" Selecting multiple Natural subprograms for IDL extraction.
" Redesign the extracted interface. See Redesigning the Extracted Interface.

® Provide IDL directions (IN, OUT, INOUT) for parameters of the Natural subprogram, see
Extracting IDL Directions (IN,0UT, INOUT).

" Selecting the REDEFINE to be used in the IDL, see Extracting Natural REDEFINES.

® Suppress or hide unneeded fields of the Natural subprogram. This keeps the IDL client interface
lean, and also minimizes the amount of data to be transferred during runtime.

The extractor wizard is described in a step-by-step tutorial; see Using the Software AG IDL Ex-
tractor for Natural.

CVM File

The CVM file (client-side server mapping file) completes the IDL file with a mapping from the
programming-language-neutral parameter definition in the IDL file to the parameters and data
types expected by the Natural subprograms (CALLNATS). Extraction is only performed if it is
needed. For information on when a CVM file is required, see When is a CVM File Required?.
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call remote
Client e MNatural
Interfacs / RPC
Object > Server
A A
as required
Natural-specific
mapping
wrap A
|.\ ) neLtral
CWM mapping
[ IDL [

£

call
Matural

If a CVM file has to be extracted, a correct interpretation of the IDL file is only possible if the CVM
file is also available. Therefore, a CVM file always has to kept in the same folder as its related the

IDL file.
A CVM file contains:

" constructs specific to Natural such as REDEFINE
" suppress parameters
" constants

® multiple interfaces

® IDL program names mapped to customized Natural names; see Using the Natural Wrapper for

the Server Side.

" etc.
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Using the Software AG IDL Extractor for Natural

This chapter describes how to use the Software AG IDL Extractor for Natural.

Extracting IDL from Natural Subprogram Sources in NaturalONE

In a NaturalONE project in Software AG Designer, IDL can be extracted directly from Natural
subprogram sources (CALLNATSs), using the following steps:

= Step 1: Start the IDL Extractor for Natural Wizard
= Step 2: Select the Natural Library from NaturalONE Project (Optional)
= Step 3: Select the Natural Subprograms from NaturalONE Project

Step 1: Start the IDL Extractor for Natural Wizard

There are various ways of starting the IDL Extractor for Natural Wizard:

= Select a NaturalONE Project
= Select a Natural Library in a NaturalONE Project
= Select Natural Subprograms in a NaturalONE Project

Select a NaturalONE Project

To extract the IDL, select the NaturalONE project in the Software AG Designer.

6 Software AG IDL Extractor for Natural
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7= NaturalONE - Natural Project/Natural-Libraries/EXAMPLESS
File Edit Mawvigate Search Project Run  Window Help

3w = W Q- Q- ] G el
ﬁ| L MaturalQrE ||._|:_‘| Resource
U Mavigator £ = O |35 calc.usm &2
= i+ akrii»a R o]
o E{%‘EﬁE% N;-wﬁ'\.xl'!- '|~:'}
=" Entirek Example Open
= '[é Matural Project- =natural-runtime (2} *
[=> .settings =] Copy
=& Matural-Libraries *
=& EXAMPLE * 3 Delete
& Err i
Ve, ..
& RES *
=@ spc *
CALC. SN fxg Import...
SENDMAILNSM “% 2 Expart...

SQUARE NSH
&= MYLIE # | Refresh
Wel exchudes

Extract IDL. ..

Wzl .natural

2 project Generate lava Client, ..
aenerate Web Service. ..
£ |

— MakuralonE 4
=1 Natural Server &3 Business Services >

2
8
i —+
= _'H + ,E Upload
E% Build Project

From the context menu, choose Extract IDL... and continue with Step 2: Select the Natural Library
from Natural ONE Project (Optional).

Select a Natural Library in a NaturalONE Project

To extract the IDL, select the Natural ONE project in the Software AG Designer.
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7= NaturalONE - Natural Project/Matural-Libraries/EXAMPLE/S
File Edit Mawigate Search Project Run  Window Help

il W Q-Q- A ] e
=1 |m MaturalONE | [ Resource

T Mavigator 52 = O || Jp caLc.usm 52
= E % ‘E ‘a E% = N;I:‘Jg- M akiimal ‘-T'.rn;:ﬂ
= Ertirei Exampls Open
= '@- Matural Project- =natural-runtime (23 *
[= .settings [i= Copy
[=-[E Matural-Libraries *
SE=YEAMPLE * 3 Delete
@ ERR Mave. ..
) RES *
=@ spc *
CALC.HSH gxg Import...

SENDMAILNSN % |2 Export. .
SQUARE NS
(&= MYLIE #'| Refresh
wel .emcludes

Exkract IDL...

Wzl natural

2 .project Generate Java Client. ..

Generate Web Service. .,
£ [

MaturalJHE r

= Natural Server 57 Business Services »

.
B
= —+l
El _'a - ,a Upload
f%, Build Project

Walidzka

From the context menu, choose Extract IDL... and continue with Step 3: Select the Natural Subpro-
grams from Natural ONE Project.

Select Natural Subprograms in a NaturalONE Project

To extract the IDL, select one or multiple Natural subprogram sources (.NSN) in the Software AG
Designer.
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7= NaturalONE - Natural Project/Matural-Libraries/EXAMPLE/SE!
File Edit Mavigate Search Project Run Window Help

e . B-0-Q- i - PGl d
= |ni MaturaloME | r\D Resource
T Navigator 57 = O ||§gh caLc.ism 52
= E| {}_:4} 1@ ‘a E% = N-;-l:; Mot a1mal ‘:'.J-n;:n
= Entirei Example Open
= 'h..—ﬂ Matural Project-=natural-runtime (23 *
== .settings = Copy
=& Matural-Libraries *
=& EXAMPLE * 3 Delete
& err "
e, ..
E REs *
=@ spc

CALC.MSH pg Import...
SENDMAIL NS~ SR
SQUARE,NSH
(&= MYLIE #'| Refrash
= excudes
r_‘-_ Exktract IDL...
Wzl . natural .
121 project Gaenerate lava Client., ..
Generate Web Service. .,
< | 3
MaturalJHE L4
| e |
!ﬁ Matural Server &3 O Business Services r
=R H,
= 1§ Upload

{%, Build Project

LI PSY E iy B

From the context menu, choose Extract IDL... and continue with Step 3: Select the Natural Subpro-
grams from Natural ONE Project.

Alternatively, you can start the IDL Extractor for Natural from the context menu of the Natural
source folder or any parent folder in the project, including the Natural library and the Project
folder.
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Step 2: Select the Natural Library from NaturalONE Project (Optional)

7= IDL Extractor for Natural

Bl=1E
Select a Library -d

The interfaces wil be extracted from Matural subprograms located in the selected library.

List of Matural libraries:

Marne

ExaMPLE
MYLIE

Total: 2

@

Select the Natural library from the list and choose Next to continue with Step 3: Select the Natural
Subprograms from Natural ONE Project.
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Step 3: Select the Natural Subprograms from NaturalONE Project

7= IDL Extractor, for Natural

Select Natural Subprograms

The interfaces will be extracted from the selected Matural subprograms, Optionally redesign
the interfaces on the following pages.,

2

Source (Makural)

List af Matural subprograms contained in library EXAMPLE:

Marme Saved Select Al
I:‘ CAaLC 2010-10-07 10:12:29
Deselect Al
REDEFIME Z2010-10-038 103619
D SQUARE 2010-10-07 10:12:24

Tokal: 3

Exkraction Settings
Redesign the intetfaces (se , selec 5, sUppress paramekers ebc,
R.edesign the interf b IN/OUTIMNGUT, select RECEFIME k k

[ |Replace special characters in parameker names with underscore;

Target (Eclipse Workspace)

Conkainer: | \Matural Projects | Erowse. .,

File Mame: | ExAMPLE

@:J « Back ][ Mexk = H Eirish H Cancel ]

In the Source pane, select at least one program from the list of Natural subprograms (CALLNATS).
You can also choose Select All or Deselect All.

In the Extraction Setting pane, check Redesign the interfaces if you want to design the extracted
interfaces to the Natural subprograms. The Next button will be enabled. See Redesigning the Ex-
tracted Interface. If you do not check Redesign the interfaces, see Natural to IDL Mapping for
default mappings.

By checking Replace special characters in parameter names with underscore under Extraction
Setting, the special characters ("$", "#", "&", "@", "/") allowed in Natural parameters can be replaced
by underscores, see also Extracting IDL Parameter Names.
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In the Target pane, select the container where the IDL file will be stored. Enter the file name of
the new IDL file. If the IDL file exists, it will be overwritten. Preserving the Software AG IDL File
in the IDL Editor documentation and optional CVM file allows you to customize the IDL (alias
names, in/out/inout modifiers) for subsequent optimized client generation steps. See CVM File.

Choose Next to redesign the interfaces. See Step 6: Redesign the Interface for Natural Subprograms
(Optional). To enable the Next button, check Redesign the interfaces.

Choose Finish to start extraction with a default mapping. For more information see Extraction
Result.

Extracting Software AG IDL File from a New Natural RPC Environment

This section covers the following topics:

= Step 1: Start the IDL Extractor for Natural Wizard

= Step 2: Create a New RPC Environment

= Step 3: Edit RPC Environment

= Step 4: Select Natural Library from RPC Environment (Optional)
= Step 5: Select Natural Subprograms from RPC Environment

12 Software AG IDL Extractor for Natural
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= Step 6: Redesign the Interface for Natural Subprograms (Optional)

Step 1: Start the IDL Extractor for Natural Wizard

Select a wizard

Exkract a new Software &G I0L file From Matural

Wizards:

|t';.-'|:|e Filker bext

= Server
== Software AG
@ web Services Stack Packaging Wizard
[=-[== EntireX
-ﬂ Entirex \Web Service Project
F 1oL Extractor For COBOL
EF IDL Exkractor For Matural
5 10 Extractar for PLT
5@ 10L Extractor for webMethods 15
S 1DL Extractor For WSDL
E! I0L Extractor For XML Document
W ICL Extractor For BML Schema
| software AG IDL File
= 3L Development

[

[ £

Press Next and continue with Step 3: Edit RPC Environment.
Step 2: Create a New RPC Environment

If no RPC environments are defined, you only have the option to Create a New RPC Environment.
The RPC environments are managed in the Preferences.

Software AG IDL Extractor for Natural 13
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- O)X

. i
Select an RPC Environment =
This wizard will help wou to extract inkerfaces From selected Matural subprograms.,

The Matural subprograms can be located in the local File system or can be accessed remotely via
an RPC environment,

(¥)Create a new RPC environment:

(:} ze existing RPC environmmenk:

L

Kt

©

Choose Create a new RPC Environment and press Next to create a new RPC environment. Con-
tinue with Step 3: Edit RPC Environment.

] Note: The folder File and the RPC environment localhosteNATSRV2800 (default RPC
server for NaturalONE) are available only if NaturalONE plugins are installed.

14 Software AG IDL Extractor for Natural
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Step 3: Edit RPC Environment

= IDL Extractor for Natural |Z|E]
i

Edit RPC Environment -
Define a new RPC Environment.
Broker Parameters
Broker ID: # ibmiz: 3762 |
Server Address: | RPCINPC42XE/CALLIAT | [E At ]

Timeaut (Seconds): | ] |

EntireX Authentication RPC Server Authentication
User ID: | | mPCUsermm: | |
Password: | | RPC Password: | |

Extractor Settings
Enter names, or use filker for range of values (wildcards * and 7 on any position, < and = as final characker only).

Libraty Marne: | MR |

Program Mame: | e )-3 |

‘Wrapper Settings
(%) Save locally
() Save remately

Environment: Mame
() Default (ibmz: 3762 @RPCINPCA2E6] CALLMAT)

® [ < Back ” Tk = l

Define the new RPC environment on this page. Required fields are Broker ID, Server Address
and the Environment Name. The timeout value must be in the range 1-9999 seconds (default: 60).

The EntireX Authentication fields apply to the broker.

The RPC Server Authentication fields apply to the RPC server. If the Natural RPC Server operates
under Natural Security,

= your user ID and password must be defined in Natural Security. If the Natural Security user ID
or password differs from the broker user ID and password, use RPC Server Authentication -
otherwise use EntireX Authentication for both.

" access to the Natural system library SYSIDL is required

Software AG IDL Extractor for Natural 15



Using the Software AG IDL Extractor for Natural

| Note: Users who do not have access rights to the Natural system library SYSIDL are not al-

lowed to extract IDL from your Natural environment.

With Extractor Settings, specify the Natural library and program name from which you want to
extract. You have the following options to select a range of Natural libraries and programs:

® wildcard asterisk "*" (any position) to list libraries or program names matching any sequence
of characters.

® wildcard question mark "?" (any position) to list libraries or program names matching any single
character.

® wildcard greater than ">" (final character only) to list libraries or program names after.
® wildcard lower than "<" (final character only) to list libraries or program names before.
® no wildcard to extract from the given library or program. If the library or program does not

exist, an error message will be displayed.

Any Natural RPC Server can be used. Only Natural libraries that reside in the FUSER system file
of the Natural RPC Server can be accessed. Special configuration is required only for operating
system IBM i; see Natural RPC Server Configuration for the IDL Extractor for Natural in the IBM i
administration documentation.

Press Next to continue.
® If Library Name (using any wildcards) matches one Natural library only, continue with Step 5:

Select Natural Subprograms from RPC Environment.

® If Library Name matches more than one Natural library, continue with Step 4: Select Natural
Library from RPC Environment (Optional).

Step 4: Select Natural Library from RPC Environment (Optional)

All Natural libraries that reside in the FUSER system file of the Natural RPC Server and that match
the specification in the Extractor Settings are listed here. See Step 3: Edit RPC Environment. This
step is skipped if exactly one Natural library matches the specification. In this case continue with
Step 5: Select Natural Subprograms from RPC Environment.

16 Software AG IDL Extractor for Natural
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Select a Library s
The inkerfaces will be extracted From Makural subprograms located in the selected library,

List of Matural libraries:

Mame

MRPCCLNT
MR PO
MRPCCUST
MRPCESP

MRPCTEST
MRPC1130
MRPC1140
MRPCZ010
MRPC2020
MRPC2030

Total: 10

® [ < Back ” Mext = ] Finish

Only Natural libraries from the Natural User System file (FUSER) are displayed. If the Natural
RPC server operates under Natural Security, Natural libraries are displayed only if you are allowed
to access the library. This means that if a library is people-protected and you do not have access
rights, it is not displayed. See also RPC Server Authentication under Step 3: Edit RPC Environment.

Select the Natural library from the list and choose Next to continue with Step 5: Select Natural
Subprograms from RPC Environment.

Step 5: Select Natural Subprograms from RPC Environment

All Natural subprograms that match the specification in the Extractor Settings are listed here. See
Step 3: Edit RPC Environment.

Software AG IDL Extractor for Natural 17
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Select Natural Subprograms

The inkerfaces will be extracted Fram the selected Matural subprograms, Optionally redesign the interfaces on the Following
pages.

Source (Matural)

List of Matural subprograms contained in library MRPCTEST:

4

Marne Savied Compiled Skatus ”~
COMYYHC ZO06-09-27 16:13:29  2006-09-27 16:13:29  Source and object in svnc,
ExAMRDEF Z010-10-20 15:22:11  2010-10-20 15:22:11  Source and object in svnc,

] SEMDMAIL 2009-09-30 15:03:53 Mo source available,
1 SEMDPOST 2010-01-22 15:10:23  2008-11-10 12:30:02  Source modified after compilation,
1 SQUARE Z009-09-30 15:04:36 Mo source available,
|_| “TYPFS1 A010-10-11 15:27:29 A01N-1n-11 15:28:79 Soere and nhieck i swnie. b

Selected: 2 of 12

Extraction Settings
(*) Extract from Matural sources {recommended)

Redesign the interfaces {set IN/OUTINOUT, seleck RECEFINES, suppress parameters etc, )
() Extract from Matural ohjects

[CJRreplace special characters in parameter names with underscore:

Target (Eclipse Workspace)

ke

Select All

Deselect Al

Containet: | IMaturalProjects |

Erowse, ..

File Name: | MRPCTEST

[]save selected sources locally on Finish

@ [ < Back ][ Mext = H Finish H

Cancel ]

In the Source pane select at least one program from the list of Natural subprograms (CALLNATSs).

You can also choose Select All or Deselect All.

In the Extraction Settings pane, specify whether the IDL is to be extracted from Natural subprogram

sources or compiled objects. The following restrictions apply:

= Extract from Natural sources (recommended)

Extracting from a source is only possible if the compiled object and source are in sync. For ex-

ample, in the screen above, source extraction is not possible for
® SENDMAIL, because there is no source, only an object
® SENDPOST, because the source is modified after last compilation

18 Software AG IDL Extractor for Natural
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= Extract from Natural objects
Extracting from an object is always possible.

Check Redesign the interfaces if you want to design the extracted interfaces to the Natural sub-
programs. The Next button will be enabled. See Redesigning the Extracted Interface. If you do not
check Redesign the interfaces, refer to Natural to IDL Mapping for default mappings.

Check Replace special characters in parameter names with underscore to substitute the special
characters '$', '#', '&', '@', '/' by underscores. See also Extracting IDL Parameter Names in Natural
to IDL Mapping.

Choose Next to continue. If multiple Natural subprograms have been selected in the Natural
subprogram selection step, redesign the next interface. You can see the current and total number
of the subprogram you are extracting from in the title (n/m).

Choose Finish to extract the interface. For further subprograms that have been selected, a default
mapping is created, see Extraction Result.

Step 6: Redesign the Interface for Natural Subprograms (Optional)

In this step, you can redesign the interface. This includes:

® Extracting Multiple Interfaces
® Extracting Natural REDEFINES
® Extracting IDL Directions (IN,0UT,INOUT)

Setting Natural Parameters to Constants
® Suppressing Natural Parameters

® Renaming a Program

Software AG IDL Extractor for Natural 19
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= —

— --_l@
. i
Design Interface for Natural Subprogram

Set IM, OUT, INCUT directions, select REDEFINES and suppress parameters to design the interface, You can use the conkext menu, Quick Fix
or buttons,

Natural Subprogram: |ERAMRDEF s | (2/2) IDL Library: NRPCTEST

4P ExaMROEF o o M =|

Natural Parameters IDL Parameters

¥ 1 ALNCTION (437 o0T

~ | = 4F FUNCTION-DATA InOut
F| B 7 ALNCTION-DATA (4161) ap N 2P FILLERT (84
2 7 REDEFIE FLVE TrONEDATA = [ Map to out > P FILLERZ (A60)

=] % 1 REDEFIME FUNCTION-DATA

&l ZFILLERL (Ad) Map to InCut -

27 MOD-DATA- (44
DATA-2

S 2 FILLER2 (a600) o MOD-DATA-2-R2-1 (AL0)
%2 5 MOD-DATA-1 [444) 4P MOD-DATA-Z-RZ-Z (ALD)
E & 2 Mo0-para-2 (a44) = &P MOD-DATA-2-RZ-3 (A10)
2 2 REDEFINE MOD-2ATA-2 Set Constant 4F MoD-DaTA-2-RZ-4 [ALD)
5 g5 2 REDEFINE MOD-DATA-2 4P FUNCTION_RESULT (81613 Out
5 3 MOD-DATA-2-R2-1 (810) 4P ERROR-CODE (84) InOut
T 3 MOD-DATA-2-R2-2 (A10) &P ERROR-TERT (A80) InOut

T 3 MOD-DATA-2-R2-3 (A10)
T 3 MOD-DATA-2-R2-4 (810)
P51 FUNCTION_RESULT (A161)
%5t | ERROR-CODE (A4)
T2 | ERROR-TEXT (4601

£

= Natural Subprogram Source

B source | BE Poant4 |BE PDROLZ

2l 2 MOD-DATA-2 (A44] ~
22 2 REDEFINE MOD-DATA-Z /*REDEFINITICN 1 OF MOD 2

23 3 MOD-DATA-2-R1-1 [A20]

24 3 MOD-DATA-2-R1-2 [420] =
25 [E ) )—DATA *REDEFINE 2 OF MOD-DATE 2 T

@ Mext = Finish ] [ Cancel

Use this page for the following tasks:
® Define the direction of parameters in the extracted interface. Choose Map to In, Map to Out or
Map to InOut for each parameter on level 1.

* Define which parameters redefined in the Natural PDA are part of the extracted interface. Choose
Map to In, Map to Out or Map to InOut for the REDEFINE base parameter or any REDEFINE path.

® Hide or suppress unneeded parameters in the extracted interface. Choose Suppress.

" Set parameters to constants and hide or suppress them in the extracted interface. Choose Set
Constant.

This page consists of the following main parts:

20 Software AG IDL Extractor for Natural
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* Top line
The top line contains the current Natural subprogram and the IDL library name. The combo
box can be used as quick navigation if more than one Natural subprogram is selected.

* Middle
The middle part contains a tab item for each interface (IDL program) extracted from the Natural
subprogram.

| Note: Itis possible to extract more than one interface (IDL program) from a Natural sub-

program. To create, rename and remove interfaces, use the toolbar on the right side of

tab folder.
Icon |Function Description
4= |Create Creates a new interface (IDL program) based on the original parameters of the Natural
subprogram.

Duplicate |Creates a new interface (IDL program) based on the current interface (active tab). All
modifications of the current interface are copied.

#4 |Rename Change the name of the current interface (active tab). The name must be unique.

# |Remove Removes the current interface (active tab). At least one interface must exist.

+ |Expand All |Expands the Natural and IDL tree.

= |Collapse All|Collapse the Natural and IDL tree.

* Middle left
Input pane. The parameters of the Natural subprogram to extract from. For each Natural sub-
program parameter you can choose one of the operations Map to In, Map to Out, Map to InOut,
Suppress and Set Constant. Additionally for REDEFINES, a quick fix is available (icons on the
left side of the pane) to choose which parameters redefined in the Natural PDA are part of the
extracted interface.

Notes:

1. The mapping operations Map to In, Map to Out, Map to InOut, Suppress and Set Constant
are also available in the context menu of the Natural parameter tree.

2. Natural parameters that are suppressed or set to constant in the interface are rendered in it-
alic type. For example, in the screen above, FUNCTION (A3) is set to constant; FILLERL (A4)
and FILLER2(A60) are suppressed; FUNCTION-DATA(A161) and its first REDEFINE path are
implicitly suppressed because the second REDEFINE path with prefix MOD-DATA-2-R2 is selected.

3. The value for Natural parameters set to constant are displayed behind the parameter in the
Natural parameter tree (e.g. in the screen above, FUNCTION (A3) [MODJ).

4. Natural parameters mapped in the interface are displayed with a green tick ().
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® Middle right
Output pane. The extracted interface (IDL).

* Bottom
Reference. The Natural subprogram source and its PDA sources, each displayed in a separate
tab.

Tips:

® The panes can be resized.
® To enlarge parameter lists, use the vertical bars on the side.

" You can close the bottom pane if it is not needed by clicking on the triangle next to Natural
Subprogram Source. In this way, you have more space for viewing the upper panes.

Use the quick navigation or choose Next to continue. If multiple Natural subprograms have been
selected in the Natural subprogram selection step, redesign the next interface. The amount of
subprograms extracted so far is indicated by the fraction next to the title (current/total).

Choose Next to continue. If multiple Natural subprograms have been selected in the Natural
subprogram selection step, redesign the next interface. You can see the current and total number
of the subprogram you are extracting from in the title (n/m).

Choose Finish to extract the interface. For further subprograms that have been selected, a default
mapping is created, see Extraction Result.
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Extracting Software AG IDL File from an Existing Natural RPC Environment

= Step 1: Start the IDL Extractor for Natural Wizard
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= Step 2: Select an RPC Environment

Step 1: Start the IDL Extractor for Natural Wizard

Select a wizard o

Exkract a new Software &G I0L file From Matural

r
I

Wizards:

|t';.-'|:|e Filker bext

= Server
== Software AG
@ web Services Stack Packaging Wizard
[=-[== EntireX
-ﬂ Entirex \Web Service Project
F 1oL Extractor For COBOL
EF IDL Exkractor For Matural
5 10 Extractar for PLT
5@ 10L Extractor for webMethods 15
S 1DL Extractor For WSDL
E! I0L Extractor For XML Document
W ICL Extractor For BML Schema
| software AG IDL File
= 3L Development

[

[ £

®

Choose Next and continue with Step 6: Redesign the Interface for Natural Subprograms (Optional).
Step 2: Select an RPC Environment

If RPC environments are defined, you can select an existing one. RPC environments are managed
in the Preferences.
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Select an RPC Environment s
This Wizard will help wou ko extract inkerfaces from selected Matural subprograms,

The Matural subprograms can be laocated in the lacal file swstem ar can be accessed remotely via an RPC enviranment,
{:} Create a new RPC enviranment

{E} Use existing RPC environment:
CIFile

EN lncalhost@MATSRYZE00
N bz 3762 @R PCINRPC42RE [CALLMAT

[CIradify the selected RPC environment

@j-' . < Back ” Mext = ]

Select Use existing RPC environment and select the appropriate RPC environment from the list
below.

If Modify the selected RPC environment is checked, the selected RPC environment can be mod-
ified before extraction starts.

Press Next to continue.

If Modify the selected RPC environment is checked, continue with Step 3: Edit RPC Environment
above.

If Modify the selected RPC environment is not checked and the Natural library name matches
one Natural library only (using any wildcard defined in Step 3: Edit RPC Environment), continue
with Step 5: Select Natural Subprograms from RPC Environment above.

If Modify the selected RPC environment is not checked and the Natural library name matches
more than one Natural library, continue with Step 4: Select Natural Library from RPC Environment
(Optional) above.

| Note: The folder File and the RPC environment localhosteNATSRV2800 (default RPC

server for NaturalONE) are available only if NaturalONE plugins are installed.
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Extraction Result

When the wizzard has finished successfully, you can see two additional files in your Eclipse project:

= .idl file
The Software AG IDL file that describes the RPC interface of the Natural server component that
implements the service's business logic together with an optional client-side server-mapping
file (CVM). The IDL file is opened with the IDL Editor. See IDL File.

® .cvm file (optional)
This file completes the IDL file with a mapping from the programming-language-neutral para-
meter definition in the IDL file to the parameters and data types expected by the Natural sub-
programs (CALLNATSs). A CVM file always has to be kept in the same folder as its related IDL
file. See CVM File.

For more information on how Natural programs are extracted, refer to Natural to IDL Mapping.
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Preferences

Use the preference page for IDL Extractor for Natural to manage the default values for the IDL

Extractor for Natural wizard.

¥= Preferences |Z|@@

|I:y|:ue filker kbext

[=)- Software AG
Ajax Developer

Application Modeler

Business Services

Zode Generation

(=~ Entiress
MET Wrapper
C Wrapper
COBOL Wrapper
Custom Wrapper
DZ 0 \Wrapper
Deployment Environments
EJB ‘Wrapper
I0L Extractar For COBOL

ckor For Matural

10L Extractor Far PLJT
I0L Extractar For WwSOL
Installation
Integration Servers
Java Wrapper
Matural Wrapper
PL/T Wrapper
RPC Environments

IDL Extractor for Natural i

The IDL Extractor For Matural Preferences are used to manage the preferred settings.
10L Extraction From
(#) Source (saved) () Object {compiled)

Replace special charackers in parameter names by underscore

The Matural RPC environments are managed on the Preferences page 'RPC Environments',

w

[ Restore Defaulks ] [ Apply

I Ok ] [ Cancel

The option IDL Extraction from Source or from Object determines from which code type the IDL

file is to be extracted.

With the check box Replace special characters in parameter names with underscore, the special
characters ("$", "#", "&", "@", "/") allowed in Natural parameters can be replaced by underscores.
See also Rules for Coding Group and Parameter Names under Software AG IDL File in the IDL Editor

documentation.

For more information on object and source extraction and character replacing, see Step 5: Select
Natural Subprograms from RPC Environment.

RPC environments are managed with the RPC Environment Manager.

Software AG IDL Extractor for Natural
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3 RPC Environment Manager

The RPC environment is managed on the RPC environment preference page. The RPC environments
can be created, edited and removed. There are several types of RPC environment: Natural, PL/I
and XML/SOAP. The RPC environment type will be used to prepare the selection lists of the fol-
lowing wizards:

® Natural RPC Server

® IDL Extractor for PL/I

= XML/SOAP RPC Server
Use the RPC Environment Monitor to check the availablity of each RPC environment.

Using these wizards, you can add new RPC environments of the respective type. To manage these
RPC environments, open the Preferences page.
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& Preferences |:|@E]

|type filter text | RPC Environments Sl

(=) Software &G ~

Ajax Developer
Application Modeler Table of defined RPC environments:

Business Services Marne Broker ID Server Address [lnsert... ]
Code Generation =N i
Falocalhost, 197 L@RPCMNATSRYZ2B00{CALLNAT localhost, 1971 RPC/MATSRYZE00/CALLNAT ¢

(=) Entires Era :
libroker :197 | @RPC/PLISRYL/CALLMAT libroker: 1571 RPCIPLISRYL/CALLNAT
MET Wirapper T plibroker @RPCS f plibeoker i §

C Wrapper
COBOL Wrapper
Cuskom Wrapper
DCOM Wrapper
Deployment Environments
EJB ‘Wrapper
I0L Extractor For COBOL
10L Extractor for Matural
I0L Extractor for PLIT
0L Extractor for WSDL
Installation
Inkegration Servers
Java \Wrapper
Matural Wrapper
PLJI Wrapper
RPC Environments
Web Service Wrapper
¥ML Mapping Editor
Tatural
UDDI Registries
‘Web Services Stack e

Manage the RPC Environments for XML/SOAP RPC Server, Matural RPC Server and IDL Extractar For PLIT.

@ Ok ] [ Cancel

To edit an existing RPC environment, select the table row and press Edit.... If multiple entries are
selected, the first entry is used.

To remove an RPC environment, select the table row and press Remove. You can select multiple
environments.

To create a new RPC environment, choose Insert....
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7= RPC Environments |;|®
.

New RPC Environment pu
Define a new RPC Environmeant,
Type: |Matural RPC Server v |

Broker Parameters
Broker ID:

Server Address: ¥ RPC/SRYLICALLNAT | [Edit...

Timeaut (Seconds): | ] |

EntireX Authentication RPC Server Authentication
User ID: | | mPCUsermm: | |
Password: | | RPC Password: | |

Extractor Settings
Enter names, or use filker for range of values (wildcards * and 7 on any position, < and = as final characker only).

Libraty Marne: | |

Program Marme: | |

‘Wrapper Settings
() Save locally
() Save remately

Environment: Mame
() Default

(%) Other: | Matural RPC Server

® [ Finish H Zancel ]

Choose the Type and enter the required fields: Broker ID, Server Address and a unique Environ-
ment Name, which will have the default format brokerID@serverAddress. The given Timeout value
must be in the range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.

The Extraction Settings are used for the IDL Extractors (Natural and PL/I) only. Use them to
specify the name of the Dataset/Library and the Member/Program name.

The Wrapper Settings are used for Natural Wrapper only, and you can specify the operation type
and target library name (not available for Save locally).
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4 RPC Environment Monitor

The RPC Environment Monitor is part of the EntireX Workbench. It is an Eclipse view that provides
a quick overview of the availability of the defined RPC environments in your workspace.

» To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

» To open the RPC Environment Monitor from a non-EntireX perspective

= Choose Window > Show View > Other > Software AG > RPC Environment Monitor.
The RPC environments are managed on the Preference page. See RPC Environment Manager.

RPC Environment Monitor 23 2]

Table of defined RPC environments:

Mame EBroker ID Server Address Skatus
:'jp Java RPC Server E localhost:1971 @ RPC/SRYIJCALLNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
M patural RPC Server @ localhost: 1971 B RPC/MATSRY2800/CALLMAT  Matural RPC Server 6,3,4.4 on WHNT-£86 (NATE311.0)
E‘E ®MLISOAP RPC Server @ localhost: 1971 @ RPC/XMLSERYER/CALLMAT  Entired %ML RPC Server 5.2.2.0.162 Windows =P 5.1 x86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.
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Symbol | Status

| Running.
e Not running.
E4AN

Unknown (at the beginning of the check or if the check was cancelled).

| Note: Additional status information (including error messages) is displayed when refreshing
the view (by a ping command to all specified RPC servers).
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Command-line Options

See Using the EntireX Workbench in Command-line Mode for the general command-line syntax. The
table below shows the command-line options for the IDL Extractor for Natural.

Task Command Option Description
Extract the Natural|-extract:natural|-brokerpassword|Password used for broker authentication.
objects from a -brokeruser User used for broker authentication.
Natural RPC .
server. -environment Name of the environment or an RPC server
description.
-filter Filter the Natural source objects. Show those
objects which match the pattern.
-help Display this usage message.
-library The library defined within the Natural RPC
Server.
-object A Natural object in the library.
-project Name of the project or subfolder where the
IDL file is stored.
-rpcpassword Password used for RPC server
authentication.
-rpcuser User used for RPC server authentication.
-timeout Timeout in seconds (default is 60).
List the Natural -Tist:natural -brokerpassword|Password used for broker authentication.
objects from a -brokeruser User used for broker authentication.
Natural RPC -
server. -environment Name of the environment or an RPC server
description.
-filter Filter the Natural source objects. Show those
objects which match the pattern.
-help Display this usage message.
-library The library defined within the Natural RPC
Server.
-object A Natural object in the library.
-rpcpassword Password used for RPC server
authentication.
-rpcuser User used for RPC server authentication.
-timeout Timeout in seconds (default is 60).
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Example

<workbench> -extract:natural -environment natBroker:2006@RPC/NATSRV1/CALLNAT -project <
/Demo -Tibrary NATDEMO -object CALC

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

The extracted IDL file will be stored in the project Demo.

If the environment name is not a defined RPC Environment in the current workspace, the name
will be interpreted as a Broker ID and RPC Server Address (brokerID@serverAddress).

The library specifies a library name and the optional object defines the progam name. Wildcard
notation with asterisk (*) can be used at the end of these names.

Status and processing messages are written to standard output (stdout), which is normally set to
the executing shell window.
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Natural to IDL Mapping

This chapter describes how Natural data types are mapped to Software AG IDL files by the Software
AG IDL Extractor for Natural and covers the following topics:

For more information on Natural syntax, refer to the Natural documentation.

Mapping Natural Data Types to Software AG IDL

The IDL Extractor for Natural maps the following subset of Natural data types to Software AG

IDL data types.

The following metasymbols and informal terms are used for the IDL in the table below.

® The metasymbols "[" and "]" surround optional lexical entities

® The informal terms n and m are sequences of numeric characters, for example 123.

Natural Data Type Software AG IDL Data Type | Description
Anumber An Alphanumeric
A DYNAMIC AVn Alphanumeric variable length
Bnumber Bnumber Binary
B DYNAMIC BV Binary variable length
C not supported
D D Date
F4 F4 Floating point (small)
F8 F8 Floating point (large)
I1 Il Integer (small)
12 I2 Integer (medium)
14 14 Integer (large)
L L Logical
Nnumberl.number]|Nnumber( .number] Unpacked decimal
Pnumberl.numberl|Pnumberl.number] Packed decimal
T T Time
Unumber Unumber Unicode
U DYNAMIC uv Unicode variable length
40 Software AG IDL Extractor for Natural



Natural to IDL Mapping

Redesigning the Extracted Interface

The IDL Extractor for Natural allows you to design the interface to your Natural subprogram
(CALLNAT). This includes

® Extracting Multiple Interfaces

® Extracting Natural REDEFINES

® Extracting IDL Directions (IN,0UT,INOUT)
® Setting Natural Parameters to Constants

® Suppressing Natural Parameters

See Step 6: Redesign the Interface for Natural Subprograms (Optional) for more information.

Extracting the IDL Library Name

The Natural library from where Natural programs are extracted is used as the IDL library name.
See 1ibrary-definition under Software AG IDL Grammar in the IDL Editor documentation.

Extracting the IDL Program Name

The Natural program name is used as the IDL program name, see program-definition under
Software AG IDL Grammar in the IDL Editor documentation.

Extracting IDL Parameter Names

For source extractions, Natural parameter names are kept and used as IDL parameters, see
simple-parameter-definitionunder Software AG IDL Grammar in the IDL Editor documentation
and group-parameter-definitionunder Software AG IDL Grammar in the IDL Editor documentation.

For object extractions, Natural programs must be compiled (cataloged) with the compiler option
SYMGEN=ON to keep original Natural parameter names. Otherwise, generic parameter names are
generated (PARAMETER-1, PARAMETER-2, etc.).

In Select Natural Sources (see Step 3: Select the Natural Subprograms from Natural ONE Project
if you are extracting from NaturalONE projects or Step 5: Select Natural Subprograms from RPC
Environment if you are extracting from a Natural RPC environment), you can choose special
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characters ($, #, & @, /) in Natural parameter names to be replaced by underscores. See Rules for
Coding Group and Parameter Names under Software AG IDL File in the IDL Editor documentation.

Extracting IDL Directions (IN,OUT,INOUT)

In most Natural subprograms, parameters have no specification for a direction. Missing a direction
is unproblematic for local calls. For remote RPC calls, however, specifying the direction helps to
reduce data sizes.

If you redesign the interface, you can define IDL directions in Step 6: Redesign the Interface for
Natural Subprograms (Optional) using the mapping operations Map to In, Map to Out, Map to
InOut.

Otherwise, IDL directions can be inserted at top-level parameters (level 1) using a Natural line
comment in the Natural subprogram (CALLNAT) interface definition (DEFINE DATA PARAMETER),
example:

DEFINE DATA PARAMETER

1 ##IN-FIELD-1 (P9) /* IN
1 JOUT-FIELD-1 (P9) /> OUT
1 #INOUT-FIELD-1 (P9) /* INOUT
1 JINOUT-FIELD-2 (P9)
1 #fIN-GROUP-1 /* IN
2 #IN-GROUP-FIELD-1 (A10)
1 #0UT-GROUP-1 /* QUT
2 #0UT-GROUP-FIELD-1 (A10)
1 fINOUT-GROUP-1 /* INOUT

2 #INOUT-GROUP-FIELD-1 (A10)
1 JINOUT-GROUP-2

2 #INOUT-GROUP-FIELD-2 (A10)
1 JINOUT-GROUP-3

2 #INOUT-GROUP-FIELD-3 (A10) /* OUT
END-DEFINE

If no direction is specified (such asin #INOUT - FIELD-2 and #INOUT - GROUP - 2 in the example above),
the default direction INOUT applies.

Specifications on a level greater than 1 (such as #INOUT-GROUP-FIELD-3 in the example above) are
ignored. Note that in IDL directions are specified on top-level fields (level 1), see attribute-T1ist
under Software AG IDL Grammar in the IDL Editor documentation.

Specifications on IDL directions are only considered when extracting from a source. If you are
extracting from an object (compiled), as described in Step 5: Select Natural Subprograms from
RPC Environment, the default direction INOUT always applies.
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Extracting Natural REDEFINES

A redefinition is a second parameter layout of the same memory portion. The parameter
#BASE-FIELD is redefined by the fields FILLER-1 thru R-P3-01.

DEFINE DATA PARAMETER

1 fBASE-FIELD (Alel)
1 REDEFINE #BASE-FIELD
2 FILLER-1 (A4)
2 FILLER-2 (A60)
2 R-P1-01 (A1)
2 R-P2-01 (A10)
2 R-P3-01 (I4)
END-DEFINE

With the extractor wizard you can select a single redefine path for IDL usage (here the fields
FILLER-1thru R-P3-01)if you redesign the interface. See An Example for Extracting Natural
REDEFINES and Step 6: Redesign the Interface for Natural Subprograms (Optional).

Extracting Multiple Interfaces

Legacy Natural subprograms often implement multiple functions in a single Natural subprogram.
The function executed is often controlled by a so-called function code or operation-code field. See
An Example for Extracting Multiple Interfaces.

With the extractor wizard you can extract the functions from the server as separate interfaces (IDL
programs). In this way, the legacy server with a single physical interface can be

" turned into a web service with operations, where the legacy functions match operations.

* called with an object-oriented wrapper such as the Java Wrapper, the NET Wrapper or the DCOM

Wrapper, where the legacy functions match methods.

Note that every function in the Natural subprogram may have a different interface described with
REDEFINE syntax. Therefore, multiple interface extraction is often combined with Extracting Nat-
ural REDEFINES.

For more information, see Step 6: Redesign the Interface for Natural Subprograms (Optional).
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Extracting Natural Arrays, Groups, X-Arrays and Variable Arrays

This section describes IDL mapping for Natural arrays and groups:
Arrays and Groups with Fixed upper Limits

Ordinary Natural arrays and groups with fixed/bound upper limits are mapped to Software AG
IDL fixed-bound-array definitions, see array-definition under Software AG IDL Grammar in the
IDL Editor documentation.

Natural syntax example:

DEFINE DATA PARAMETER
1 fFARRAY1 (I4/1:10) /* Tower bound is fixed at 1, upper bound is 10
1 #fARRAY2  (I4/10) /* shortcut for (A5/1:10)
1 #fGROUP1 (10)
2 #FIELDL (I2)
2 #fFIELD2 (A10)

END-DEFINE
X-Arrays and X-Groups

For X-arrays (eXtensible arrays) the number of occurrences is flexible at runtime. The number of
occurences can be resized, i.e. increased or reduced. It is defined by specifying an asterisk (*) for
index bounds.

Natural syntax example:

DEFINE DATA LOCAL
1 #X-ARRAY1 (A5/1:*) /* lower bound is fixed, upper bound is variable
1 #fX-ARRAY2 (A5/*)  /* shortcut for (A5/1:%)

END-DEFINE

Natural X-arrays are mapped to Software AG IDL unbounded-array definitions, see
array-definition under Software AG IDL Grammar in the IDL Editor documentation.

Natural X-arrays with variable lower bounds are not supported by Software AG RPC technology,
example:
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DEFINE DATA PARAMETER
1 #X-ARRAY1 (A5/*:10) /* lower bound is variable, upper bound is fixed

END-DEFINE
Variable Arrays and Variable Groups

In a Natural parameter data area (PDA), you can specify an array or group with a variable number
of occurrences. This is done with the index notation 1: V. The maximum number of occurrences
for such an array is either passed to the subprogram using an extra parameter such as
fFARRAY1-LIMIT (see example below), or it can be accessed using the system variable *0CCURRENCE.

Natural syntax example:

DEFINE DATA PARAMETER
1 #fARRAY1-LIMIT (I4) /* extra parameter to pass the upper limit
1 #FARRAY1 (I4/1:V)

END-DEFINE

Natural variable arrays are mapped to Software AG IDL unbounded-array definitions, see
array-definition under Software AG IDL Grammar in the IDL Editor documentation.

If the Natural server program uses a separate parameter such as #ARRAY1-LIMIT (see the example
above) instead of *0CCURRENCE to determine the upper bound limit, it is required to extract this
extra parameter, too. During runtime, it is also required to specify the number of occurences in a
calling RPC client.

In a Natural server program, Natural variable arrays

" cannot be resized for direction INOUT, which means you can only reply the same number of
occurrences to the RPC client.

® cannot be used for direction OUT either, because they cannot be created (instantiated). You may
get error 20050031 during extraction.

Arrays and Groups with Mixed Dimensions (X, Variable and Fixed)

Natural arrays and groups with a mixture of fixed variable and eXtensible dimensions are not
supported by Software AG RPC technolgy, example:
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DEFINE DATA PARAMETER

1 {FARRAY1 (I4/1:10,1:*%) /* first dimension fixed and second eXtensible

1 {#ARRAY2 (I4/1:10,1:V) /* first dimension fixed and second variable

1 JFARRAY3 (I4/1:V,1:*) /* first dimension variable and second eXtensible

END-DEFINE

Extracting Natural Structure Information (IDL Levels)

Source Extractions

Natural levels are always kept. This means that the structure in the extracted IDL is the same as
in the original Natural program.

Object Extractions

® UNIX or Windows
In UNIX or Windows RPC environments, Natural levels are not kept. The IDL is extracted in a
flat way, where

® all IDL parameters are at level 1;
* all Natural groups are removed;
* Natural fields within groups using repetition (PERIODIC GROUPS) are mapped to IDL arrays;

* the dimension of Natural arrays within groups using repetion (PERIODIC GROUPS)is increased
in the IDL. For example, a one-dimensional array may become a two-dimensional or three-
dimensional IDL array depending on the dimension of the group;

= z/OS
In z/OS RPC environments, the Natural programs must be compiled (cataloged) with the compiler
option SYMGEN=0N to keep Natural levels, otherwise flat extraction is carried out.

Extracting Parameters defined with OPTIONAL

For a parameter defined without OPTIONAL, a value must be passed from the invoking Natural
object, i.e. the caller.

For a parameter defined with OPTIONAL, a value can, but need not be passed from the invoking
Natural object to this parameter. With the SPECIFIED option, a Natural server can find out at
runtime whether an optional parameter has been defined or not.

The IDL Extractor for Natural ignores the 0PTIONAL specification, i.e. the parameter is extracted
as without the OPTIONAL specification. See the Natural Documentation for more information.
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EntireX RPC technology does not support optional IDL parameters. Using pure Natural RPC
(Natural client to Natural server), Natural optional parameters are supported.

Setting Natural Parameters to Constants

Setting parameters to constant values and suppressing them in the IDL is part of the redesign
process of the extracted interface. This keeps the IDL client interface lean. See An Example for Set
Constant.

EntireX and Natural RPC make sure the constant value is passed to the Natural server during
runtime. No data is transferred between the RPC client and the RPC server.

For more information, see Step 6: Redesign the Interface for Natural Subprograms (Optional).

Suppressing Natural Parameters

Hiding or suppressing unneeded parameters in the IDL is part of the redesign process of the ex-
tracted interface. This keeps the IDL client interface lean and minimizes the amount of data to be
transferred during runtime.

EntireX and Natural RPC make sure to provide low values as input for suppressed parameters to
the Natural server called (blank for IDL type A, zero for numeric data types such as IDL I, N and
P). No data is transferred between an RPC client and the RPC server.

For more information, see Step 6: Redesign the Interface for Natural Subprograms (Optional).

Renaming a Program

Renaming a program to a different name in the IDL is part of the redesign process of the extracted
interface. You can adjust the short Natural name to a meaningful longer name for better readability.
See An Example for Extracting Multiple Interfaces where the original Natural name CALC is renamed
to IDL names ADD, SUBTRACT, MULTIPLY etc.

EntireX and Natural RPC make sure the original Natural server is called during runtime. For more
information, see Step 6: Redesign the Interface for Natural Subprograms (Optional).
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Handling CVM Files

A client-side server mapping file (CVM) enables the RPC server to correctly support special Nat-
ural syntax such as REDEFINE and other special situations. If one of these elements is used, the
EntireX Workbench automatically extracts a CVM file in addition to the IDL (interface definition
language), or a CVM file is generated by the Natural Wrapper for a server skeleton. The CVM file
is used at runtime to marshal and unmarshal the RPC data stream.

CVM Files in the EntireX Workbench

In the EntireX Workbench a CVM file has to relate to an appropriate IDL file; always keep the IDL
file and the CVM file together in the same folder.

= If there is a CVM file and a corresponding IDL file, at least one of the IDL programs in the cor-
responding IDL file requires server-mapping information to correctly call the target server. For
those IDL programs, there is a CVM entry (line) in the Workbench CVM file.

= If there is an IDL file but no corresponding CVM file, there is no IDL program that requires
server mapping information.

Source Control of CVM Files

Because CVM entries within a CVM file contain text data only, a Workbench CVM file is text-based
(although it is not intended for human consumption). Therefore, you can include it in your source
control management together with the IDL file and the Natural source(s) as a triplet that should
always be kept in sync.

Compare CVM Files

For CVM files in the EntireX Workbench format, you can use a third-party file/text compare tool to
check if two files are identical.

The CVM entries (corresponding to lines in a Workbench CVM file) contain a creation timestamp
at offset 276 (decimal) in the format Y VY YMMDDHHIISST. The precision is 1/10 of a second.
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Handling CVM Files

When is a CVM File Required?

For the IDL Extractor for Natural

Natural Syntax |IDL Extractor for Natural|CVM Regired |More Information

For the Natural Wrapper

Natural Wrapper CVM Required | More Information

IDL program name is not a valid Natural name |yes Step 2: Customize Natural Server Names under
and is therefore adapted, or the Natural Using the Natural Wrapper for the Server Side
program name is customized within Natural ONE
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Examples for Redesigning the Extracted Interfaces

This chapter gives examples on how to redesign the extracted interface.

An Example for Set Constant

This example turns the CALC server into an ADD server. The CALC server used here can be found
in Basic RPC Server Examples - CALC, SQUARE under Client and Server Examples for Natural in the
Natural Wrapper documentation.

R R b B b e b b e b e b e b e b e b b e e B e b e b e e S e b e b e b e e e b e e b e e b e b e b i e S i 4
*

* CALC RPC Server Example for Natural

*
khkkkhkkhkhkhkhkkhkhhhkhkkhkhhhkhkhkhhhhhkkhhhhkkhkkhhhhkhkhhhhhkhkkhhhhkhkkhhrhkkhhrrkkhkhrrkkhkhkik

DEFINE DATA

PARAMETER
1 #fOPERATION (A1)
1 ffOPERAND1 (I4)
1 ffOPERAND2 (I4)
1 #FUNCTION-RESULT (I4)
LOCAL
1 {FTMP (I4)
END-DEFINE

*

MOVE O TO #FUNCTION-RESULT
DECIDE ON FIRST VALUE OF #OPERATION
VALUE "+
COMPUTE #FUNCTION-RESULT
VALUE "-'
COMPUTE #FUNCTION-RESULT = #fOPERANDI - #OPERAND2
VALUE "*'
COMPUTE #FUNCTION-RESULT
VALUE '/'
IF #0PERAND2 NE O THEN
COMPUTE #FUNCTION-RESULT = #fOPERAND1 / #fOPERAND2

J#OPERAND1 + #fOPERAND2

J#OPERAND1 * #fOPERAND2

END-IF
VALUE '%'
IF #fOPERAND2 NE O THEN
DIVIDE jfOPERAND2 INTO #OPERANDL GIVING #TMP ©

REMAINDER #FUNCTION-RESULT
END-IF
NONE VALUE
IGNORE
END-DECIDE
END

Extraction without a redesign leads to an interface (IDL program) in which extracted parameters
and Natural subprogram parameters are identical:
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Library 'EXAMPLE' Is
Program 'CALC' Is
Define Data Parameter

1 Operation (A1) In

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Qut
End-Define

Calling such an interface with an RPC client means providing the ADD function as a value on the
operation parameter in the same way legacy callers do.

After the redesign, the IDL looks as follows:

Library 'EXAMPLE' Is
Program 'ADD' Is
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Out
End-Define

This process is called “Redesigning the interface”, which can be seen as manual step in the overall
extraction process. See Step 6: Redesign the Interface for Natural Subprograms (Optional).

Setting parameters to constant values and suppressing them in the IDL is often done together with
multiple interfaces, where the function code or operation-code field has to be set to a constant. See
An Example for Extracting Multiple Interfaces for a more advanced example.

» To Redesign the interface and to set a constant for the parameter operation

1  Make sure to check Redesign the interfaces in Step 5: Select Natural Subprograms from RPC
Environment.

2 In Step 6: Redesign the Interface for Natural Subprograms (Optional), proceed as follows:
Design interface for ADD Server

® Choose Set Constant for parameter Operation and enter "+" as value.

® Choose Rename from the toolbar and change the name to "ADD".
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An Example for Extracting Multiple Interfaces

Multiple functions are often implemented in a single Natural subprogram, for example in An Ex-
ample for Set Constant. The CALC server implements the functions ADD, SUBTRACT, MULTIPLY,
DIVIDE and MODULO in one source.

Extraction without a redesign leads to an interface (IDL program) in which extracted parameters
and Natural subprogram parameters are identical:

Library 'EXAMPLE' Is
Program 'CALC' Is
Define Data Parameter

1 Operation (A1) In

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Qut
End-Define

Calling such an interface with an RPC client means providing the function (ADD, SUBTRACT,
MULTIPLY, DIVIDE or MODULO) as a value on the operation parameter in the same way legacy
callers do.

The interface above would

" result in a class with a single method if it was wrapped with an object-oriented wrapper (Java
Wrapper, NET Wrapper, DCOM Wrapper).

= offer CALC as only operation if it was used as web service.

A modern design of the same interface would provide more specialized interfaces. Each interface
may have fewer parameters compared to the original Natural subprogram. Parameters that are
obsolete for a function are not offered in the corresponding interface, for example the parameter
Operation in our example. This keeps the interface lean and clear and makes it easier to use from
the perspective of an RPC client.

This process is called “Redesigning the interface”, which can be seen as manual step in the overall
extraction process. See Step 6: Redesign the Interface for Natural Subprograms (Optional).

After the redesign, the IDL looks as follows:
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Library 'EXAMPLE' Is
Program "ADD' Is
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Out
End-Define

Program 'SUBTRACT'
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Out
End-Define

Program '"MULTIPLY'
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Qut
End-Define

Program 'DIVIDE'
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Out
End-Define

Program 'MODULO'
Define Data Parameter

1 Operandl (I4) In

1 Operand? (I4) In

1 Function_Result (I4) Out
End-Define

By redesigning the interface you can turn the legacy interface of the CALC server into a more
modern, object-oriented interface. In case the redesigned interface above is wrapped

® with an object-oriented wrapper (Java Wrapper, NET Wrapper, DCOM Wrapper), this results in
a class with five methods — ADD, SUBTRACT, MULTIPLY, DIVDE and MODULO, a real class/method
design.

" as web service, also five operations are offered.

» To Redesign the interface and extract multiple interfaces

1  Make sure to check Redesign the interfaces in Step 5: Select Natural Subprograms from RPC
Environment in the extractor wizzard (see Extracting Software AG IDL File from an Existing
Natural RPC Environment).

2 In Step 6: Redesign the Interface for Natural Subprograms (Optional), proceed as follows:
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® Design interface for ADD
® Choose Set Constant for parameter Operation and enter '+' as value.
® Choose Rename from the toolbar and change the name to ADD
® Design interface for SUBTRACT
® Choose Set Constant for parameter Operation and enter '-' as value.
® Choose Rename from the toolbar and change the name to SUBTRACT
* To design MULTIPLY, DIVIDE or MODULO, proceed as for SUBTRACT
® Enter ™' as value for Operation and rename it to MULTIPLY.
* Enter /' as value for Operation and rename it to DIVIDE.

® Enter '%' as value for Operation and rename it to MODULO.

An Example for Extracting Natural REDEFINES

REDEFINEs are often used in Natural. The example below illustrates a simple redefinition where
the parameter #BASE-FIELD is redefined by the fields FILLER-1 thru R-P3-01.

DEFINE DATA PARAMETER

1 #BASE-FIELD (Al161) /* first parameter
1 REDEFINE #BASE-FIELD /* second parameter

2 FILLER-1 (A4)

2 FILLER-2 (A60)

2 R-P1-01 (A1)

2 R-P2-01 (A10)

2 R-P3-01 (14)
END-DEFINE

You can select a single REDEFINE path of the same base field for one interface only. If you require
more than one REDEF INE path of the same base field, extract multiple interfaces — for each REDEFINE
path a separate interface, see An Example for Extracting Multiple Interfaces.

» To redesign the interface and extract a REDEFINE path

s Choose Map to In, Map to Out or Map to InOut either for

" the REDEFINE base parameter, here parameter #BASE-FIELD (A161) /* first parameter,
or

" any REDEFINE path, here REDEFINE#fBASE-FIELD /* second parameter
y p
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